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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Gamma SIP Trunk service and Avaya IP Office Server Edition R9.1.

The Gamma SIP Trunk service provides PSTN access via a SIP trunk connected to the Gamma
Voice Over Internet Protocol (VolIP) network as an alternative to legacy Analogue or Digital
trunks. Gamma is a member of the Avaya DevConnect Service Provider program.

Readers should pay attention to section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Gamma SIP Trunk service and Avaya IP Office Server Edition 9.1.
Customers using this Avaya SIP-enabled enterprise solution with Gamma’s SIP Trunk are able
to place and receive PSTN calls via a dedicated Internet connection and the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks. This approach generally
results in lower cost for the enterprise customer.

Avaya IP Office Server Edition solution can be deployed in a pure IP environment, supporting IP
endpoints and SIP trunking, or in a hybrid scenario, which provides additional support for TDM
stations and trunks. In the sample configuration, a hybrid deployment is used, consisting of a
Primary Server running Avaya IP Office Server Edition Linux software, and an Avaya IP Office
Expansion System on an IP Office 500 V2 chassis.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
Server Edition to connect to the Gamma SIP Trunk service via a SIP Trunk over the internet.
This configuration (shown in Figure 1) was used to exercise the features and functionality listed
in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing
To verify SIP trunking interoperability the following features and functionality were exercised
during the interoperability compliance test:
e Incoming PSTN calls to various phone types including H.323, SIP, Digital and Analogue
telephones at the enterprise.
e Allinbound PSTN calls were routed to the enterprise across the SIP trunk from the
Service Provider.
e Outgoing PSTN calls from various phone types including H.323, SIP, Digital, and
Analogue telephones at the enterprise.
e All outbound PSTN calls were routed from the enterprise across the SIP trunk to the
Service Provider.
e Calls using the G.711A and G729 codecs.
e Fax calls to/from a group 3 fax machine to a PSTN connected fax machine using G711A
codec.
e DTMF transmission using RFC 2833 with successful VVoice Mail/Vector navigation for
inbound and outbound calls.
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e Inbound and outbound PSTN calls to/from Avaya Communicator Softphone client.

e Various call types including: local, long distance, international, toll free (outbound) and
directory assistance.

e Caller ID presentation and Caller 1D restriction.

e User features such as hold and resume, transfer, and conference.

e Off-net call forwarding and mobile twinning.

2.2. Test Results

Interoperability testing of the test configuration was completed with successful results for
Gamma’s SIP Trunk service with the following observations:
e T.38 fax was not tested during the compliance testing.
e No inbound toll free numbers were tested, however routing of inbound DDI numbers and
the relevant number translation was successfully tested.
e Access to Emergency Services was not tested as no test call had been booked with the
Emergency Services Operator.

Note: During the compliance test, the SIP trunk to Gamma was configured to terminate on the
Primary Server. On IP Office Server Edition systems, the fax mode supported on the Primary
Server is G.711 fax. T.38 Fax is supported across a single IP Office 500 V2 Expansion System or
in other scenarios where the Primary Server is not involved (for example, between Expansion
Systems (500 V2) over SIP/Analogue trunks where direct media is used). For this reason, if T.38
were to be used with Gamma, the service provider’s SIP trunk should be terminated in an
Expansion System (500 VV2) and not on the Primary Server.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Gamma SIP trunking, please contact an authorised Gamma Partner or
visit the website at www.gamma.co.uk.
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3. Reference Configuration

Figure 1 illustrates the test configuration. The test configuration shows the enterprise site
connected to the Gamma SIP Trunk service.
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Figure 1: Test Setup Gamma SIP Trunk service to Simulated Avaya Enterprise
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In the sample configuration, Avaya IP Office Server Edition solution consists of the following
main components:

e |P Office Server Edition Primary Server.

e |P Office Server Edition Expansion System (500 V2).

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have been
changed to a private format and all phone numbers have been obscured beyond the city code.

The Primary Server consists of a HP Proliant DL360 server, running Avaya IP Office Server
Edition Linux software. The server is the only mandatory component required to support SIP
trunking and IP endpoints. Avaya Voicemail Pro runs as a service on the Primary Server

The optional Expansion System (500v2) is used for the support of digital, analog and additional
IP stations. It consists of an Avaya IP Office 500v2 with analog and digital extension expansion
modules.

IP endpoints located at the enterprise site include Avaya 1600 Series IP Telephones (with H.323
firmware), Avaya 96x1 Series IP Telephones (with H.323 firmware), Avaya 1140e SIP
Telephones, Avaya Analogue Telephone and fax machine. The site also has a Windows 7 PC
running Avaya IP Office Manager to configure Avaya IP Office as well as Avaya Communicator
for Windows Softphone client. Some IP endpoints were registered to the Primary Server while
others were registered to the Expansion System. Mobile Twinning is configured for some of the
IP Office users so that calls to these user’s extensions will also ring and can be answered at the
configured mobile phones.
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software | Release/Version
Avaya

Avaya IP Office Server Edition Version 9.1.1.0 build 10
Avaya Preferred Edition (Voicemail Pro) Version 9.1.1.0 build 3
Avaya IP Office 500 V2 Version 9.1.1.0 build 10
Avaya 1603 Phone (H.323) 1.3.5

Avaya 96x1 Series Phone (H.323) 6.3.0

Avaya Communicator for Windows (SIP) | 2.0.3.30

Avaya 1140e (SIP) FW: 04.04.18.00.bin
Avaya 98390 Analogue Phone N/A

Gamma

Genband S3 SBC Code version 8.2.4.0
Ericsson TSS4 Softswitch Code version R1F.5R.514.052
Marconi XCD Softswitch Code version 4.2.1

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500 V2 and also when deployed with all configurations of IP Office Server Edition
without T.38 Fax Service.

5. Configure Avaya IP Office

This section describes the Avaya IP Office Server Edition configuration necessary to support
connectivity to the Gamma SIP Trunk Service. It is assumed that the initial installation and
provisioning of Server Edition Primary Server and Expansion System has been previously
completed and therefore is not covered in these Application Notes. For information on these
installation tasks refer to [1] in the Additional References section.

The solution is configured through Avaya IP Office Server Edition Manager PC application.
From the PC running the IP Office Manager application, select Start = Programs = IP Office
- Manager to launch the application. Navigate to File = Open Configuration, select the
proper Avaya IP Office Server Edition system, making sure the box for Open with Server
Edition Manager is checked. Log in using the appropriate credentials.
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system inventory of the servers and links for administration and configuration tasks.
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In the screens presented in this section, the View menu was configured to show the Navigation
pane on the left side, the Group pane in the center and the Details pane on the right side. These
panes will be referenced throughout the rest of this section.

Note that the Navigation pane includes solution settings, under the Solution menu, which apply
to all the systems in the Server Edition solution, and individual system settings, each grouped
under the Primary Server and the Expansion System menus.

Standard feature configurations that are not directly related to the interfacing with the service
provider are assumed to be already in place, and they are not part of these Application Notes.
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5.1. Verify System Capacity

The configuration and features described in these Application Notes require an IP Office Server
Edition system to be licensed appropriately. If a desired feature is not enabled or there is
insufficient capacity, contact an authorized Avaya sales representative.

Licenses for an IP Office Server Edition solution are based on a combination of centralized
licensing done through IP Office Server Edition Primary Server, and server specific licenses that
are entered into the configuration of the system requiring the feature. SIP Trunk Channels are
centralized licenses and licensing is administered through the configuration of the Primary
Server. Note that when centralized licenses are used to enable features on other systems, such as
SIP trunk channels, the Primary Server allocates those licenses to the other systems only after it
has met its own license needs.

To verify that there is a SIP Trunk Channels license with sufficient capacity, Navigate to System
(1) under Primary on the navigation pane and then navigate to License = SIP Trunk
Channels. In the Details Pane, verify that the License Status is valid and that the number of
Instances is sufficient to support the number of SIP trunk channels provisioned by Gamma.
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5.2. LAN2 Settings

In the test configuration, the LANZ2 port was used to connect Avaya IP Office to the external
internet. To access the LAN2 settings, first navigate to System = GSSCP SE in the Navigation
Pane where GSSCP SE is the name of the IP Office. Navigate to the LAN2 - LAN Settings
tab in the Details Pane. The IP Address and IP Mask fields are the public interface of the IP
Office. All other parameters should be set according to customer requirements. On completion,
click the OK button (not shown).

# QOperator (3)
%3 Solution

W@ User(34)
&-5af Group(l)
G- @% Short Code(51)
4% Directory(0)
~£1 Time Profile(0)
; Account Code(0)
=-§5 User Rights(9)
@ Location(0)
GSSCP SE
) System (1)

%

4 Line (2)
-~ Control Unit (9)
_@ Extension (4)

GSSCP SE v System v GSSCP SE -
Configuration | GSSCP SE
@-& BOOTP (10)

[ System TAT\IIW LAN2 ‘ DNS I Voicemail I Telephony | Directory Services l System Events I SMTP l

Number Of DHCP IP Addresses 124

| LAN Settings |VolP lNetworkTopology“
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IP Mask 255 . 255 . 255
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On the VoIP tab in the Details Pane, the H323 Gatekeeper Enable box is checked to allow the
use of Avaya IP Telephones using the H.323 protocol. Check the SIP Trunks Enable box to
enable the configuration of SIP trunks. If Avaya Communicator along with any other SIP
endpoint is to be used, the SIP Registrar Enable box must also be checked. The Domain Name
has been set to the customer premises equipment domain “avaya.com”. If the Domain Name is
left at the default blank setting, SIP registrations may use the IP Office LAN2 IP Address. All
other parameters shown are default values.

The RTP Port Number Range can be customized to a specific range of receive ports for the
RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to a UDP
port in the configurable range for calls using LANZ2.

Avaya IP Office can also be configured to mark the Differentiated Services Code Point (DSCP)
in the IP Header with specific values to support Quality of Services policies for both signalling
and media. The DSCP field is the value used for media and the SIG DSCP is the value used for
signalling. All other parameters should be set according to customer requirements. On
completion, click the OK button (not shown).

e GSSCP SE-

} System I LAMNL ‘ LANZ | pNS Veicamail | Telephony | Directory Services l System Events I SMTP I SMDR | Twinning | Coducs

| LAN Settings ]\ VelP 1} Network Topology |

¥ H322 Gatekeeper Enable
] Auto-create Extn Auto-create User [ ] H323 Remote Extn Enable

[¥] SIP Trunks Enable

[¥] SIP Registrar Enable

Auto-create Extn/User "] SIP Remote Extn Enable
Domain Name
¥l upp UDP Port 5060
Layer 4 Protocol W] TCp TCP Port 5060
| TLS TLS Port 5061 - 5061
Challenge Expiry Time (secs) 10
RTP
Port Number Range
Minimum 49152 - Maximum 53240

Port Number Range (NAT)
Minimurm 49152 e Maximum 53246

| Enable RTCP Monitaring on Port 5005
RTCP collector IP address for phones 0 0 0 0
Keepalives

Scope -

DiffServ Settings

B8 : DSCP(Hex) |BE 9 Video DSCP(Mex) |FC S DSCP Mask (Hex) 88 T SIG DSCP (Mex)
46 o pscep 46 I Video DSCP 63 2 DSCP Mask 34 2 SIG DSCP
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On the Network Topology tab, select the Firewall/NAT Type from the pulldown menu to
Open Internet. With this configuration, the STUN Server IP Address and STUN Port are not
used as NAT was not required for this configuration, therefore resulting in no requirement for a
STUN server. The Use Network Topology Info in the SIP Line was set to None in Section
5.6.2. Set Binding Refresh Time (seconds) to 200. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service provider.
Default values were used for all other parameters. On completion, click the OK button (not
shown).

= GSSCP SE

j_System Iﬁj LAN2 ‘ DNS ] Voicemail l Telephony | Directory Servicesﬂi”System Events l SMTP | SMDR I Twinning I Codecs.[

’ LAN Settings I VolP ‘ Network Topolegy ‘
Network Topology Discovery
STUN Server Address STUN Port 3478 :
Firewall/NAT Type {Open Internet v
Binding Refresh Time (seconds) 200 s
Public IP Address a 0 0 a Run STUN Cancel
Public Port
uDP 0 C
TCP 0 =
LS 0 >
[] Run STUN on startup
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5.3. System Telephony Settings

Navigate to System (1) under Primary on the navigation pane and then to Telephony 2>
Telephony tab to configure the Telephony settings for the Primary Server. Choose the
Companding Law typical for the enterprise location. For Europe, ALAW is used. Uncheck the
Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call transfer to the
PSTN via the Service Provider across the SIP trunk.

The Maximum SIP Sessions field appears only in Server Edition systems. This value determines
the number of SIP Trunk Channel licenses reserved for concurrent sessions on SIP trunks
provided by this server. These licenses are reserved from the pool of SIP Trunk Channel licenses
shown on Section 5.1. Defaults were used for all other settings.

On completion, click the OK button (not shown).

7 GSSCP SE*

‘ System Iiftll ILANZ l DNS 17Voicemraiil Telephony ‘ Direst?ry ServisesJWSystem Events | SMTP | SMDR | Twinning | Codecs I VoIP Security | Contact Center

Telephony ‘ Park&Pagel Tones & Musicl Rirng Tones | M l Call Log ] TUI

Default Name Pricrity |Favour Trunk v
Media Connection Preservation Enabled X,
Phone Failback Automatic v ‘

Dial Delay Time (secs) 4 Companding Law
. Switch Line
Dial Delay Count 4
Default No Answer Time (secs) 15 = 7 U-Law U-Law Line
Hold Timeout (secs) 15
) 9 A-Law @ A-Law Line
Park Timeout (secs) 300
Ring Delay (secs) 5 )
|| DSS Status
Call Priority Promotion Time (secs) Disabled ]
s |¥| Auto Hold
Default Currency {GBP Vl
e Dial By Name
Maximum SIP Sessions 255

[¥] Show Account Code

[T] Inhibit Off-Switch Forward/Transfer

| Restrict Network Interconnect

Include location specific information

Navigate to Expansion = System (1) and repeat the steps above to configure the Telephony
settings for the Expansion System. As the SIP trunk will be terminated on the Primary Server, it
was not necessary to enter a value in the Maximum SIP Sessions field in this case; therefore the
default value of 0 was used (not shown).
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5.4. System Twinning Settings

To view or change Twinning settings, select the Twinning tab as shown in the following screen.
The Send original calling party information for Mobile Twinning box is not checked, and the
Calling party information for Mobile Twinning is left blank in the reference configuration.
With this configuration, the true identity of a PSTN caller can be presented to the twinning
destination (e.g., a user’s mobile phone) when a call is twinned out via the Gamma SIP Trunk.

P GSSCP SE*

| System | LANL [ LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events [ sMTP | sMDR | Twinning

["] Send original calling party information for Mobile Twinning

Calling party information for
Mobile Twinning

5.5. Codec Settings

Navigate to the Codecs tab on the Details Pane. Check the available Codecs boxes as required.
Note that G.711 ULAW 64K and G.711 ALAW 64K are greyed out and always available. Once
available codecs are selected, they can be used or unused by using the horizontal arrows as
required. Note that in test, G.711 ALAW 64K and G.729(a) 8K CS-ACELP were the supported
codecs used for testing.

7 GSSCP SE*
% System | LANL I LAN2 I DNS | Voicemail | Telephony | Directory Services l System Events l SMTP | SMDR | Twinning‘ Codecs
RFC2833 Default Payload 101 .
Available Codecs Default Codec Selection
Unused Selected
[¥] G.711 ULAW 64k G.711 ULAW 64K 3> G711 ALAW 64K
[¥] G711 ALAW 64K G.722 64K G.729(a) 8K CS-ACELP
7] G722 64K

[V] G.729(a) 8K CS-ACELP
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5.6. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Gamma
SIP Trunking service. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by IP Office Manager to create a SIP Line. Follow the steps in Section 5.6.1 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New => SIP Line. Then, follow the steps outlined in Section 5.6.2.

5.6.1. SIP Line From Template

DevConnect generated SIP Line templates are always exported in an XML format. These XML
templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500v2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., \temp) on the same computer
where IP Office Manager is installed. Rename the template file to
AF_Gamma_SIPTrunk.xml. The file name is important in locating the proper template
file in Step 5.
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2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable

Template Options. Click OK.

" IP Office Manager Preferenc_ L’&l

I Preferences I Directories l Discovery } Visual Preferences l Security l Validation!

Icon Size [Small ']
[¥] Multiline Tabs
@

|
| Enable Template Options

v

Enable Template Creation

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down

menus in Step 5.

" Avaya IP Office Manager GSSCP_IPOS [9.1.0.437] [Administrator(A
File Edit View | Tools | Help
RRE-H |2 E Extension Renumber...
GSSCP IPO9 Line Renumber.., 1
_ Connect To...
IP Office:
Export »
@& BOOTP (2) SCN Service User Management
#-¢# Operator (3) 3
=+ GSSCP_IPO9 Busy on Held Validation
%39 System (1)
. l.w9 GSSCP I MSN Cenfiguration
if—ﬁ Line (5) Print Button Labels
(H-<=> Control Uni ;
-4 Extension (3 Import Templates in Manager
w-§  User (40)
-4pf Group (5)
G+-@% Short Code (66)

In the pop-up window (not shown) that appears, select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure. Click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to

the IP Office template directory.
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New - New SIP Trunk From Template.

:;:‘F-‘; Line (5) TNCIUWUTK \_Ullllyulﬂllull
""" 5 Layer 4 Protocol @
..... o 6 —]
..... o 13
11 New > h
..... :" 14 —]
""" - :[ 9] New SIP Trunk from Template ]
T ‘...“.Conltr )  Create SIP Trunk Template |
""" 2| X Cut Ctrl+X
..... w 3]
L.ew 4|53 Copy Ctrl+C
..... < 5 7’ peste ‘-:tr[""-"
- Extenl 5 pejete Ctrl+Del
w-@  User :
.\,,@ Grouf ¥ Validate
(-@% Short Connect To... Ctrl+T
By Servic )
G-, RAS New from Template (Binary)
=€ Incon Export as Template (Binary)
: E . W s

5. In the subsequent Template Type Selection pop-up window, select Gamma from the
Service Provider pull-down menu as shown below. These values correspond to parts of
the file name (AF_Gamma_SIPTrunk.xml) created in Step 1. Click Create new SIP
Trunk to finish creating the trunk.

' — o h
%" Template Type Selection LEL_JQ

Locale United Kingdom (UK English)

Service Provider |Gamma v | [] Display Al

[ Create new SIP Trunk | | Cancel |

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Section 5.6.2.
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5.6.2. Manual SIP Line Configuration

On the SIP Line tab in the Details Pane, configure the parameters below to connect to the SIP

Trunking service.

e Leave ITSP Domain Name blank as none was required for this configuration.

On completion, click the OK button (not shown).

Ensure the In Service box is checked.

Ensure the Check OSS box is checked.

Set Method for Session Refresh to Reinvite.

Set Send Caller ID to Diversion Header.

Default values may be used for all other parameters.

i)

SIP Line - Line 18

SIP Line iTransportISIP URIIVOIP }SIP Credentials | SIP AdvancedlEngineeringi

Line Number 18

ITSP Domain Name

URI Type [sip
Location [Cloud
Prefix

National Prefix

International Prefix

Country Code

Name Priority

System Default

Description

In Service

Check 00S

Session Timers
Refresh Method

Timer (seconds)

Forwarding and Twinning

Originator number

Send Caller ID

Redirect and Transfer
Incoming Supervised REFER
Outgoing Supervised REFER
Send 302 Moved Temporarily
Outgoing Blind REFER

™

¥
Reinvite v
On Demand
[Diversion Header vJ
{Never v ]
[ Never v ]
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Select the Transport tab and set the following:

Set ITSP Proxy Address to the IP address of the Gamma SIP proxy.
Set Layer 4 Protocol to UDP.

Set Send Port to 5060 and Listen Port to 5060.

Set Network Topology Info to None.

On completion, click the OK button (not shown).

7 SIP Line - Line 18*

[SIP Ling| Transport SIP URI|VolP | T38 Fax|SIP Credentials|SIP Advanced | Engineering

ITSP Proxy Address 192.168.61.195

Network Configuration

Layer 4 Protocol lUDP v] Send Port 5060 =
Use Network Tepology Info [None v] Listen Port /5060 S
Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar  [V]

Separate Registrar

After the SIP line parameters are defined, the SIP URIs that Avaya IP Office will accept on this
line must be created. To create a SIP URI entry, first select the SIP URI tab. Click the Add
button and the New Channel area will appear at the bottom of the pane.

7 SIP Line - Line 18
‘SIP LinelTransportWi/olP lT38 FaxlSlP CredentialslSlP AdvancedlEngineering'
| Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls [ Add...
Remove
Edit...
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For the compliance test, a single SIP URI entry was created that matched any number assigned to
an Avaya IP Office user. The entry was created with the parameters shown below.

e Set Local URI, Contact, Display Name and PAI to Use Internal Data. This setting
allows calls on this line whose SIP URI matches the number set in the SIP tab of any
User as shown in Section 5.8.

e For Registration, select 0: <None> from the pull-down menu.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 18 was defined that was associated to a single line (line 18).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

T SIP Line - Line 18"
1P Line Transport|SIP URI [Volp[738 Fax| iP Credentilssip AdvancedEngineering
Edit...
Edit Channel _—
Via <None> [LJ
Local URI Use Internal Data v [ Cancel ‘
Contact Use Internal Data v
Display Name Use Internal Data v
PAI Use Internal Data v
Registration 0: <None>» v
Incoming Group 18
Outgoing Group 18
Max Calls per Channel 10 -
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Select the Vol P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

Select Custom from the drop-down menu.

Select G.711 ALAW 64K and G.729(a) 8K CS-ACELP codecs.

Set the Fax Transport Support box to G.711.

Set the DTMF Support field to RFC2833/RFC4733. This directs Avaya IP Office to
send DTMF tones using RTP events messages.

Uncheck the VVolIP Silence Suppression box.

Check the Re-invite Supported box, to allow for codec re-negotiation in cases where the
target of the incoming call or transfer does not support the codec originally negotiated on
the trunk.

Check PRACK/100rel Supported to advertise the support for provisional responses and
Early Media to the Gamma network.

Default values may be used for all other parameters.

7

SIP Line - Line 18

|SIP Line!TransportISIP URI; VoIP ;SIP CredentialsiSIP AdvancedlEngineering%

[¥] Re-invite Supported

[7] Codec Lockdown

Codec Selection {Custom X [] Allow Direct Media Path
Unused Selected Force direct media with phones
G.711 ULAW 64K S G.711 ALAW 64K
G.722 64K G.729(a) 8K CS-ACELP || PRACK/100rel Supported

[7] G.711 Fax ECAN

Fax Transport Support {6.711 v t
DTMF Support | RFC2833/RFC4733 -
Media Security Media Security Features Disabled
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Select the SIP Advanced tab. For outbound calls with privacy enabled, Avaya IP Office will
replace the calling party number in the From and Contact headers of the SIP INVITE message
with “anonymous”. Avaya IP Office can be configured to use the P-Preferred-Identity (PPI) or P-
Asserted-Identity (PAI) header to pass the actual calling party information for authentication and
billing purposes. By default, Avaya IP Office will use the PPI header for privacy. For the
compliance test, PAl was used for the purposes of privacy.

To configure Avaya IP Office to use the PAI header for privacy calls, on the SIP Advanced tab,
check Use PAI for Privacy. All other fields retained their default values.

7 SIP Line - Line 18° -8 X v
S Lmeti Transport {SIP URL VolP | 738 Fax SIP Credentials SIP Advanced Engineering
Addressing Meda
Assocuton Method By Source P adcvess - Alow Empey INVITE

. Send Empty re-INVITE
Call Routing Method Request UM v

Aliow To Tag Change
Suppress DNS SRV Lockups P-Eeely-Media Support Hone >4

Send SilenceSupps Off

Sentey
Icben Force Early Direct Meda
Use Phome Contet -

Mecta Conmection

ecta Conmecticr Disabled =

Add user=phone Preservation
Use = for International
Uze PAI for Privacy v Cafl Contro
Use Demain fer PAI R

Call Initiation Timeout [y} 4
Swap From and PAl
Caler ID from From heades Call Queuing Timeout (m) 5
- e £ .
Send From In Cleee Service Busy Response 486 - Busy Here v
Cache Auth Credentinh / No User R g

ont S Spont v

A g 406-Regquest Teneout -

Uses-Agent and Server Headers Send

Action on CAC Location Allow Vo " =

Limst

Suppress Q550 Reazon
Header

Emulste NOTIFY for REFER

Note: It is advisable at this stage to save the configuration as described in Section 5.11.
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5.7. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance test.

5.7.1. Short Codes and ARS for the Primary Server

To create a short code, right-click Short Code in the Navigation Pane and select New. On the
Short Code tab in the Details Pane, configure the parameters as shown below.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. The example shows 9N; which will be invoked when the user dials 9
followed by the dialed number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N which will allow an IP Office user to dial the digit 9
followed by any telephone number, symbolized by the letter N. The Telephone Number
field is used to construct the Request URI and To Header in the outgoing SIP INVITE
message.

e Setthe Line Group Id to 50: Main (ARS configurable Short Code).

On completion, click the OK button (not shown).

= 9N;: Dial
Short Code
Code 9N;
Feature Dial v
Telephone Number N
Line Group ID 50: Main v
Locale vl
Force Account Cede
Force Authorization Code |-
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Navigate to Primary = ARS on the left pane. The following screen shows the default ARS
Short Code entry for the Primary Server. Select and edit the existing “?” short code to change its
Line Group ID from the default O to Line Group ID 18 as defined in Section 5.6.

i R BOOTP 10)
#-¢% Openttor (3)
< %@ Solution
#4 Uwr39)
4 4 Growpll)
i1 9% Short Code31)
- Deectory0)
01" Time Profiled))
a Account Codel®)
4y User Rightsi9)
5 Location)
=<0 GS50P SE
=% System {1}
% G55CPSE
19 Line ()
& “w Controt Unit 9)
¥ 4p Extenyion (4)
Ef User[5)
= O Group (1)
i+ 9% Sheet Code (2

s Sennce (0)
12 Incoming Call Route

i« P Rowte (2)

W Licence (23)
= ARS{Y)

o 50 Man

5 Locstion 1)

Dis! Delay Time Syvem Defauh (§) =

Description

I Service W Out of Servace Route

Time Profie " | — Ot of Hours Route

None>

¥! Check User Call Barring

Festure Line Geoup ID
Disd Emergency 0

Telephone Number
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5.7.2. Short Codes and ARS for the Expansion Server

On the left Navigation pane, select Expansion = Short Code. The screen below shows the
default “?” short code present in the Expansion System configuration. This short code routes any

dialed number that has no other match to the ARS record 50:Main of this system. No changes
were made to the default values on this screen.

Configuration | = 2: Dial
o Short Code

v o0 Code

v User)

+ 9 Groupld) Festure sl =

& % Snoet CodelS1)
Tdephone Number
Line Group B O Man =2
Lecale

Foece Accoure Code

Foece Authonzation Code

Verify the ID of the H.323 line connecting the Expansion System to the Primary Server. To do
this, select Expansion = Line on the navigation pane and select the H.323 line on the Group

pane (Line 17 on the screen below). Make note of the Outgoing Group ID on the Details pane
(99999 below).

Configuration

—
K—

IP Office Line - Line 17

#-R BOOTP (10)
Operator (3)
Solution
& & User(34)
(5@ Group(l)
(8% Short Code(51)
=& Directory(0)
£ Time Profile(0)
-8 Account Code(0)
&-§3 User Rights(9)
i@ Location(0)
(-9 GSSCP SE
(=% GSSCP_IPO2

%3y System (1)

=174 Line (9)

@ 1

2

5

7

18

9

- 10
,\‘

m

= Control Unit (4)

Line  [Short Codes|VolP Settings

Line Number 17 =

Transport Type I WebSocket Client v]
Networking Level [sen -
Security I Unsecured v I
Gateway

Address 10 10 3 120

Location Cloud v
Password sessccese

Confirm Password LLTITTTIT)

Description

Telephone Number

Prefix

QOutgoing Group ID 99999
Number of Channels 250
Outgoing Channels 250

Port 80
SCN Backup Options

[] Supports Fallback
[] Backs up myIP Phones
[] Backs up my Hunt Groups

[] Backs up my Voicemail
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Navigate to Expansion = ARS on the left pane. The following screen shows the default ARS
entries for the Expansion System. A default “?” short code in the ARS entry with Line Group
ID 99999 is used to route all calls to Line 17 (as seen on the previous screen) to the IP Office

Server Edition Primary Server

1 Main®
ARs |
|
Time Profile <None> —) - Qut of Hours Route <None> v]
Code Telephone Number Feature Line Group ID l ‘ Add...
2 . Dial 99999 l )
Remove
| Edit..
30 e A\lternate Route l(None> V|

The following example summarizes the settings shown on the previous screens. When a user on
the Expansion System dials 9 followed by the number called, the digits are matched to the local
?/Dial/./Main short code, which sends the call to the local ARS 50:Main. The ARS routes the
call to Line Group ID 99999, the H.323 line to the Primary Server, sending the digits unaltered,
including the 9 prefix. The digits received at the Primary Server are matched to the
9N/Dial/N/Main system short code. This routes the call to ARS 50:Main on the Primary Server,
having removed the 9 prefix. The ARS then routes the call to Line Group ID 18, the external
SIP trunk to the Gamma SIP Trunk service.
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5.8. User and Extensions

In this section, examples of IP Office Users and Extensions will be illustrated. In the interest of
brevity, not all users and extensions shown in Figure 1 will be presented, since the configuration
can be easily extrapolated to other users.

A new SIP extension may be added by right-clicking on Extension (not shown) in the
Navigation pane and selecting New SIP Extension. Alternatively, an existing SIP extension may
be selected in the group pane. The following screen shows the Extn tab for the extension
corresponding to an Avaya 1140E. The Base Extension field is populated with 89107, the
extension assigned to the Avaya 1140E. Ensure the Force Authorization box is checked.

= SIP Extension: 8003 89107
‘Bxn  |voP | 738 Fax|

Extension Id 8003

Base Extension 89107

Caller Display Type On

Reset Volume After Calls ™

Device Type . i Avaya 1140E SIP (Language: ENGLISH)

Location [Automatic =
Medule 0
Port 0
Force Authorisation =]
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The following screen shows the VVolP tab for the extension. The IP Address field may be left
blank or populated with a static IP address. The new Codec Selection parameter may retain the
default setting System Default to follow the system configuration shown in Section 5.5.
Alternatively, Custom may be selected to allow the codecs to be configured for this extension,
using the arrow keys to select and order the codecs. Other fields may retain default values.

= SIP Extenslon: 8003 89107
[ Extn |[VoIP || 738 Fax|
| i s
I 5 5 - - VolP Silence Suppression
] Local Hold Music
Codec Selection System Default ¢ V] Re-invite Supported
[ 7] Codec Lockdown
G711 ULAW 64K [G,711 ALAW 84K
G.722 64K | [¥] Allow Direct Media Path
G.729(a) BK CS-ACELP
G.723.1 6K3 MP-MLQ
Reserve License INunc - |
Fax Transport Suppoert | Nene - |
TOM->1P Gain | Defauit - |
IP->TDM Gain | Deraun - |
DTMF Support | RFC2833 - |
3red Party Aute Answer | Nene ~

To add a User, right-click on User in the Navigation pane, and select New. To edit an existing
User, select User in the Navigation pane, and select the appropriate user to be configured in the
Group pane. Configure the SIP parameters for each User that will be placing and receiving calls
via the SIP line defined in Section 5.6.2. To configure these settings, select the User tab if any
changes are required. The example below shows the changes required to use Avaya 1140E which

was used in test.

W

Extn89107: 89107

| stp

l Personal Directory I Web Self-Administration i

User }-Voicemail ! DND I ShortCodes I Source Nu-mbers ] Telephony [ Forwarding i Dial In ] Voice Recording ] Button Programming
Name Extn89107

Password esccee

Confirm Password sssesse

Conference PIN

Confirm Conference PIN

Account Status Enabled -
Full Name Ext 89107

Extension 89107

Email Address

Locale [ VI
Priority {5 vl
System Phone Rights 1None - I
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Select the Telephony tab. Then select the Supervisor Settings tab as shown below. The Login
Code will be used by the Avaya 1140E telephone user as the login password.

SIP | Personal Directory | Web Self-Administration |

User | Voicemail I DND I ShortCodes I Source Numbers' Telephony lForwa:qin_g_l Dial In I Voice Recording | Button Programming

Call Settings | Supervisor Settings | Muiti-line Options | Call Log | TUI |

Login Code sessee

Confirm Login Code [TTTTT]

Login Idle Pericd (secs)
Monitor Group [<None> y]
Coverage Group [ <None> v]

Status on No-Answer [Logggd On (No change)

Reset Longest Idle Time
@ AllCalls

() External Incoming

Force Login

Force Account Code

Force Autherization Code
Incoming Call Bar

Outgoing Call Bar

Inhibit Off-Switch Forward/Transfer
Can Intrude

Cannot be Intruded
Can Trace Calls

Deny Auto Intercom Calls

Remaining in the Telephony tab for the user, select the Call Settings tab as shown below.
Check the Call Waiting On box to allow multiple call appearances and transfer operations.

SIP | Personal Directory | Web Seff-Administration |

User | Voicemail | DND | ShortCodes | Source Numbers | Telephony | Forwarding | Dialn | Voice Recording | Button Programming

Call Settings | Supervisor Settings | Multi-line Options | CaliLog [ TUI |

Outside Call Sequence [D_efault Ring

v] Call Waiting On

Inside Call Sequence [Default- Ring v] [] Answer Call Waiting On Hold
Ringback Sequence [Default Ring v] Busy On Held
No Answer Time (secs) iSystem Default (15) g-i Offhook Station
Wrap-up Time (secs) i2 E”
Transfer Return Time (secs) !Off Ei
Call Cost Mark-Up 100
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Next, select the SIP tab in the Details Pane. To reach the SIP tab click the right arrow on the
right hand side of the Details Pane until it becomes visible. The values entered for the SIP Name
and Contact fields are used as the user part of the SIP URI in the From header for outgoing SIP
trunk calls. These allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP line (Section Error! Reference source not found.). As
such, these fields should be set to one of the DDI numbers assigned to the enterprise from
Gamma.

7 Extn89107: 89107*

‘A User lVoicemaiI I DND l ShortCodes | Source Numbers | Telephony I Forwarding I Dial In I Voice Recording | Button Programming
SIP } Personal Directory I Web Self-Administration |

SIP Name 0163000000d.

SIP Display Name (Alias) 0163xc0c000d

Contact 016300000

[] Anonymous

The following screen shows the Mobility tab for user 89107. The Mobility Features and Mobile
Twinning are checked. The Twinned Mobile Number field is configured with the number to
dial to reach the twinned mobile telephone over the SIP Trunk. Other options can be set
accordingly to customer requirements.

b Extn89107: 89107*

SIP l Personal Directory I Web Self-Administration“!

User {Vuicemail.l DND l ShortCodes“ “Source Nu-mbers l Telephony I Forwarding l Dial In l Voice Recording l Button Programming | Menu Programming} Mobility ‘

1
Twin Bridge Appearances
Twin Coverage Appearances
Twin Line Appearances
[] Mobility Features
[¥] Mobile Twinning

Twinned Mobile Number

9003538940000l
(including dial access code)

Twinning Time Profile <None> v

Mobile Dial Delay (secs) 2
Mobile Answer Guard (secs) |0
| Hunt group calls eligible for mobile twinning
_| Forwarded calls eligible for mobile twinning
[] Twin When Logged Out
|| one-X Mobile Client
| Mobile Call Control

Mobile Callback
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5.9. Incoming Call Routing

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within IP Office Server Edition solution. Note that in Server Edition
systems, Incoming Call Routes are solution settings, shared by all the systems in the solution.

Incoming call routes could be defined for each DID number assigned by the service provider. In
a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in the
IP Office Primary Server or Expansion System. The routing decision for the call is based on the
parameters previously configured for the users SIP Name, Contact within the SIP tab, already
populated with the assigned Gamma DID numbers (Section 5.8).

To create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New. On the Standard tab of the Details Pane, enter the parameters as shown below:
e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section
Error! Reference source not found..
e Set the Incoming Number to the incoming number that this route should match on.
Matching is right to left.
e Default values can be used for all other fields.

7 18

Standard | Voice Recording l Destinations |

Bearer Capability lAny Voice v
Line Group ID 18 v
Incoming Number 0163000000l

Incoming Sub Address

Incoming CLI
Locale [ v}
Priority |1- Low -|
Tag
Hold Music Source lSystem Source V}
Ring Tone Override None v
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On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. On completion, click the OK button (not shown). In this example, incoming
calls to the test DDI number 016xxxxxxx1 on line 18 are routed to extension 89107.

| Standard | Voice Recording | Destinations |

| TimeProfile Destination
»  Default Value |89107 Extn89107 |~

5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections. A screen like the one shown below is
displayed, showing details for those systems where the system configuration has been changed
and needs to be saved on the system. Reboot or Merge is shown for each system under the
Change Mode column, based on the nature of the configuration changes made since the last
save. Note that clicking OK may cause a service disruption. Click OK to save the configuration.

e
%" Send Multiple Configurations 7 [EIM
- Change - Incoming Outgoing Error
Seleck IPOffice Mode RebootTime Call Barring Call Barring Statusr Progress
» M ossce st Reboot +|1515 l \ F Q |
@] |Gsscppo2 Merge v|1515 | [ \ W Q | o%
[ OK ] [ Cancel I I Help
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6. Gamma SIP Trunk Service Configuration

Gamma is responsible for the configuration of the SIP Trunk service. The customer will need to
provide the public IP address used to reach the Avaya IP Office at the enterprise. Gamma will
provide the customer the necessary information to configure the SIP connection to the SIP
Trunking service including:

e |P address of SIP Trunking SIP proxy.
Network SIP Domain.
Supported codecs.
DDI numbers.
All IP addresses and port numbers used for signalling or media that will need access to
the enterprise network through any security devices.

7. Verification Steps

This section includes steps that can be used to verify that the configuration has been done
correctly.

7.1. SIP Trunk status

The status of the SIP trunk can be verified by opening the System Status application. This is
found on the PC where IP Office Manager is installed in PC programs under Start > All
Programs = IP Office - System Status (not shown).

Log in to IP Office System Status at the prompt using the Control Unit IP Address for the IP
office. The User Name and Password are the same as those used for IP Office Manager.

AVAVA IP Olfice System Status

' Logon

Fmartrast Bhart 10 manbre o e ETINIENED

From the left hand menu expand Trunks and choose the SIP trunk (18 in this instance). The
status window will show the status as being idle and time in state if the Trunk is operational. IP
address has been changed.
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IP Office System Status

w(l) Status CUtilization Summary Alarms

B Extonsions (18)

B Trnke (9) SIP Trunk Summary
Line: 1 Peer Domaln Name! slpif{192.168.230.98
Liney 2 Resolved Address! 192.168,230,98
v5 -
i AR Line Number: 18
Line: 9
Line: 10 Number of Administered Channels: 10
[ ine: 18| Number of Channels in Use: 0
Administered Compression! G729.4, G711 A
Sllence Suppression: (=l
2 y SIP Trunk Channel Licenses: Unlimited
B 1P Hetworking 0%
SIP Trunk Channel Licenses in Use: 0

SIP Device Meatures:

1Channel Rel Current State Time in State  Remote Media Codec  Connaction Caller 10 or Other Party on Call

) o Addrass Ty Dialed Diglts
2 Idlle:

3 Idls

K] Idle

L3} ide

6 idie 146102

7 Idle 01146102

8 Idle 01146102

9 Idle 01:46:02

10 Tdle 01:46:02

7.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can
be accessed from Start - Programs = IP Office - Monitor. The application allows the
monitored information to be customized. To customize, select the button that is third from the
right in the screen below, or select Filters - Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked. All SIP messages will appear in the
trace with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select
the desired color.

n | ; Voo | VPN WaN U Te . | 5= | Ja l
atw | ©M | o | ECod | FrameRoly | GOD | w323 | imeisce |
15DN | KepMavg | Dinctow | Meaw | FFP | B2 | Rouing | Soivices  SIP | Gymern |
Lverin
LT ] _] STUN 1™ 51" Dect
Packets
1° SIP Reg/Opt R ISP Mo Ak
I~ RIFPAsXpt Ta I~ SIF Mo Tw
I BIPCafw I T Moty Re
I SIPCM T T Nty T
WV Sip Nk [ s 1P Flter trows ivws rens e |
v SipTs 1 hew I
Dolowlt A¥ | Cleov AR | TanOswar| Tanseas| ox | cece |
SovuFie | toudfile | LosdFatel Fi|  Somct e |
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As an example, the following shows a portion of the monitoring window of a SIP handset
attempting registration to IP Office.

T3 Avayn IP Office RU.1 SysMoniter - [STOPPED] Monitoring 10,10 9. 100 (GSSCP_IPO2): Log Settings - C:-\Docyments and Settings). . \sysmoniforseits

Fle EG Vew FlRers Stabs  Help
=al A8 Xy g 2 -
Viat SIV/2.0TTF 10,009, 1345 L4062 al a8 branch-s@nGiabf adddar )dSricad Lo
Pax-Tocwarde: 70
From: AP BR060BaYAYS. COR> S TAGT SR ASSC N
To: <2ip:05060Favays. cond
Call-ID: 4ARPTIELALIOASDhe9n
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8. Conclusion

These Application Notes describe the procedures required to configure the connectivity between
Avaya IP Office R9.1 Server Edition and Gamma SIP Trunk solution as shown in Figure 1.

The reference configuration shown in these Application Notes is representative of a basic
enterprise customer configuration and demonstrates Avaya IP Office can be configured to
interoperate successfully with Gamma’s SIP Trunk service. Gamma’s SIP Trunk service is a
SIP-based Voice over IP solution providing businesses a flexible, cost-saving alternative to
traditional hardwired telephony trunks. The service was successfully tested with a number of
observations listed in Section 2.2.
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Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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